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ABSTRACT

The aim of this paper is to present several popular methods for in vitro culture of osteocytes
and osteocyte cell lines. Osteocytes are located extremely suitably within the calcified bone
matrix to sense mechanical signals, and are equipped with a multitude of molecular features
that allow mechanosensing. However, osteocytes are more than specialized mechanosensing
cells. Several signaling molecules are preferentially produced by osteocytes, and osteocytes
hold a tight reign over osteoblast and osteoclast formation and activity, but also play a role as
endocrine cell, communicating with muscles, or organs as remote as the kidneys. In order to
facilitate further research into this fascinating cell type, three protocols will be provided in this
paper. The first protocol will be on the culture of mouse (early) osteocyte cell lines, the second
on the isolation and culture of primary mouse bone cells, and the third on the culture of fully

embedded human osteocytes within their own three dimensional bone matrix.



INTRODUCTION

Bone research has long focused on the formation and function of osteoblasts and osteoclasts,
the cells that form and resorb bone. This while osteocytes were regarded as rather inactive
cells, entombed within the calcified matrix, unable to move. One of the pioneers in osteocyte
research was Peter Nijweide, who was the first to isolate osteocytes from the calvariae of
chickens [1], using an antibody to what was later discovered to be the avian variant of Phex [2].
The protocol for the isolation of these osteocytes is not dissimilar to other techniques allowing
the isolation of osteoblasts and osteocyte-like cells from mouse and human bone [3, 4]. Since
the development of that first protocol, osteocytes were discovered to play a key role in the
mechanical adaptation of bone to mechanical loading, and to be dynamic cells that produce a
vast multitude in signaling molecules [5-7]. One of these signaling molecules produced more or
less exclusively by osteocytes, sclerostin, may inhibit bone mass accrual by osteoblasts, and
sclerostin antibodies are currently being investigated as a potential osteoporosis therapy [8].
Osteocytes, rather than osteoblasts, are the main source of Receptor activator of nuclear factor
kappa-B ligand (RANKL) in adults, determining the extent of osteoclast formation and activity
[9, 10]. Osteocytes also play a role in phosphate homeostasis, by communicating with the
kidney, making bone a truly endocrine organ [11]. In order to facilitate future research in this
cell, playing such an important role in regulation of bone metabolism, we provide three
protocols for the culture of osteocytes, either as cell line, primary cell, or as cells in their
original three dimensional matrix.

In the first part of this paper, we provide a detailed protocol for culturing MLO-Y4 and MLO-A5
cells, which are currently still one of the most frequently used osteocyte cell lines. Immortal
clonal cells such as MLO-A5 and the MLO-Y4 cells are routinely used as osteocyte models, which
represent different stages of osteoblast to osteocyte differentiation. MLO-AS5 cells are derived
from osteocalcin promoter-driven T-antigen transgenic mice and have higher expression of ALP
and osteocalcin compared to primary osteoblasts and MLO-Y4 osteocytes [12]. They mineralize
spontaneously in culture, even in absence of phosphate supplementation and are thought to
represent post-osteoblast/pre-osteocyte cells that mineralize the osteoid matrix they are

embedded in [12]. MLO-Y4 cells are a more mature osteocyte cell model compared to MLO-Y5



cells, derived from the same transgenic mice used for the generation of MLO-AS cells, although
they likely still represent a relatively early osteocyte. Even though these cells represent early
osteocytes, they already display the stellate morphology, with dendritic processes typical of
osteocytes embedded in matrix. MLO-Y4 cells also possess the ability to respond to mechanical
stimulation by releasing Prostaglandin E, [13], ATP [14] and nitric oxide [15], integral to
osteocytes’ orchestration of adaptive bone remodeling. This makes them very useful for
studying factors that alter the response of osteocytes to mechanical stimuli. MLO-Y4 cells have
relatively high expression of osteocalcin and connexin-43 with low collagen type 1, periostin
and alkaline phosphatase activity compared to primary osteoblasts and clonal cells [12, 16].
However, both MLO-A5 and MLO-Y4 cells have their limitations, such as the lack of sclerostin
expression and low DMP-1 expression by MLO-Y4 cells. This makes MLO-Y4 cells less suitable
for studying signal molecule production by mature osteocytes. Alternative cell lines that have
been used to study sclerostin expression include the Sa0S2 osteosarcoma cell line and the
osteoblast-like UMR-106 cells, which are described elsewhere [17, 18]. IDG-SW3 [19] and
Ocy454 [20] are osteocyte cell lines that express relatively high levels of SOST/sclerostin as well
as FGF23, both key regulators of bone homeostasis, and could therefore be used to study
osteocyte signaling towards other cell types. Readers are encouraged to pick the osteocyte cell
line that best suits their research question.

The second part of this paper describes the isolation and culture of primary osteocytes from
mice. This protocol allows the study of osteocytes with deletions of specific genes, by isolation
of osteocytes from knockout mice. As with all osteocyte culture models, care should be taken
to monitor the osteocyte-like phenotype of these cells, as osteocytes in vivo are no longer able
to divide, and will be quickly overgrown by other cell types, limiting the useful life span of the
culture. In addition, osteocytes are embedded in calcified bone matrix in vivo, determining their
tree dimensional shape, and thereby likely affecting their ability to sense mechanical signals. It
remains to be shown to what extent osteocytes cultured in two dimensions on tissue culture
plastic retain their complete osteocyte-like phenotype. Therefore, several protocols have been
developed lately for the culture of osteocytes or osteocyte-like cells in three dimensions in a

collagen matrix; e.g. the co-culture of osteoblasts on top of MLO-Y4 osteocytes cultured in



three dimensional collagen gels [21]. Although these cultures likely give a better approximation
of the natural environment of the osteocyte, these cultures still require the use of cell lines or
isolated cells, with all their limitations. In addition, gels do not exactly mimic the physical,
anatomical, and chemical make-up of the matrix. Therefore, the third part of this protocol
describes a method to culture human osteocytes embedded in their native matrix. Human bone
tissue is cut in to small pieces and treated with collagenase to remove lining cells and bone
marrow cells. These denuded bone pieces, containing osteocytes in their native matrix, can be
cultured for up to 7 days.

Altogether, these protocols represent current popular osteocyte culture methods, although
new methods that more thoroughly represent the bone niche are continuously being

developed.



PROTOCOL I: Culture of Osteocyte Cell Lines

MATERIALS

Coating of tissue culture plastic

1.
2.

Rat tail type-I collagen solution (Cat no A1048301, Thermo Fisher Scientific, Paisley, UK).

0.02M Acetic acid solution.

Tissue culture reagents

1.
2.

Sterile phosphate buffered saline (PBS) without Ca?* and Mg?*, pH 7.4.

a-MEM with 1gm/L D-Glucose, L-glutamine, and pyruvate; containing ribonucleosides
and deoxyribonucleosides.

Complete culture media (cCM): a-MEM supplemented penicillin (100U/mL) and
streptomycin (100pg/mL), 2.5% fetal bovine serum (FBS) + 2.5% calf serum (CS) (both
heat inactivated, Hyclone).

Trypsin-EDTA solution containing 0.25% trypsin (Invitrogen, Paisley, UK)

Dimethyl sulfoxide (DMSO) for freezing cells.

In-vitro mineralization of MLO-A5 cells

1.
2.
3.

L-Ascorbic acid (Sigma-Aldrich, working concentration: 50ug/mL)

Dexamethasone (Sigma-Aldrich, working concentration: 10nM)

Inorganic phosphate solution (iPOa4) containing 4 parts of Na;HPO4 and 1 part of
NaH2PO4. The mixture is filter sterilized and stored at 4°C (working concentration 5mM).
Ethanol 70%

40mM Alizarin Red S, pH 4.2

Staining of MLO-Y4 for cell number and dendrite length

1.
2.

10% buffered formalin
0.1% Crystal Violet



METHODS

Coating tissue culture plastic with collagen

The following steps should be performed in aseptic conditions.

1. Dilute the sterile type-I collagen solution to a concentration of 0.15mg/mL in filter
sterilized 0.02M acetic acid using chilled pipettes.

2. Use 0.2mL/cm? collagen solution to coat the tissue culture flasks or plates. Let them
coat for 1hr at room temperature before removing the solution. (The excess collagen
solution can be reused 5 times and should be stored at 4°C between uses).

3. The collagen coated plastic can be used immediately, after rinsing twice with PBS. The
tissue culture flasks or plates can also be stored for later use by allowing the collagen
solution to dry prior to storage at 4°C (up to a month). Rinse the stored flasks or plates

twice with PBS prior to using.

Maintenance of MLO-A5 and MLO-Y4 cells

1. Place a vial containing 5x10° to 1x10° cells in a 37°C water bath just long enough for
them to thaw. Mix the cells with 10mL cCM and centrifuge at 250g for 5min.

2. Resuspend pellet and culture cells in cCM at 37°C in a humidified atmosphere of 95% air
and 5% CO,. We routinely culture the cells in collagen-coated T75 flasks till 70% (MLO-
Y4) or 80% (MLO-A5) confluence, before passaging. MLO-Y4 cells should not be allowed
to grow above 70% confluency to maintain their phenotype. Care should be taken to
avoid high flow rates during media changes, as osteocyte-like cells are extremely
sensitive for fluid flow-derived shear stress.

3. To passage cells, discard the spent media and rinse the cells twice with PBS.

4, Add 3mL of freshly thawed trypsin-EDTA to each flask and incubate at 37°C for 5 min.

Ensure that the trypsin-EDTA solution completely covers the flask surface area.



Subsequently, check the flask under the microscope to check for detachment of cells. If
bulk of cells are still attached, tap the flask gently and check again. Alternatively,
incubate the cells at 37°C for a further 5 min.

Following detachment, collect the cells in 10mL cCM media and centrifuge at 250g for
5min. Discard the supernatant and resuspend the cell pellet in 2mL of cCM.

Perform a viable cell count with trypan blue using a Neubauer haemocytometer or
alternative methods. Typically, 2.0-2.5 x10° cells are harvested from a T75 flask. We
routinely seed 0.5-1x10° cells per T75 flask depending on how frequently they are
needed.

To freeze cells, resuspend the cell pellet from step 6, in 60% a-MEM, 30% FBS and 10%
DMSO. Store 1x10° cells/mL in each cryovial and freeze at -80°C using a Mr.Frosty.

Transfer to liquid nitrogen for long term storage.

MLO-A5 in vitro mineralization

1.

Seed 2x10%/cm? MLO-A5 cells in cCM at 37°C in a humidified atmosphere of 95% air and
5% COs till confluent (typically 2-3 days; see Note 1).

At confluence (day 0), rinse the cells with PBS and change the media to osteogenic
media (OM): a-MEM with 0.5-2% FBS, 50ug/mL L-ascorbic acid and 10nM
dexamethasone (see Note 2).

Replenish with fresh OM every 2-3 days until two days (day 5) prior to the end of
experiment, when 5mM iPOg solution is added to promote mineralization (see Note 3).
At the end of the experiment (day7), the extent of mineralization can be assessed by
staining the cultures with Alizarin red. Rinse the cells twice with PBS and fix them
overnight at 4°C with 100% ethanol.

Rinse in PBS and stain with 40mM Alizarin red solution (pH 4.2) for 1 hr with gentle
whirling on an orbital shaker.

Remove the excess stain and wash the cultures with 95% ethanol till no more unbound

dye is released and air dry (see Note 4).



7.

Scan the plates on a flatbed scanner (600 dpi) and percentage area of mineralization can

be quantified using ImageJ (available at: http://imagej.nih.gov/ij/) (see Note 5).

Quantification of mineralization using ImageJ

1.
2.

Open the image file to be quantitated in ImageJ (lllustrated in figure 1).

Click on ‘Image > Adjust > Color Threshold’ to open a new window titled ‘Threshold
color’. Set the ‘Threshold color’ to ‘Black’ (for better contrast) and ‘Color space’ to ‘HSB’.
Using the sliders provided, set the ‘brightness’ to accommodate the full spectra (0-255)
and adjust the ‘hue’ and ‘saturation’ to threshold for the dark red areas of
mineralization stained by Alizarin red (see Note 6).

Change the thresholded image to grey-scale by clicking on ‘Image > Type > 8 bit’
Subsequently, click on ‘Image > Adjust > Threshold’, and move the sliders to 0-0 to select
all the previously thresholded (black) areas.

Click ‘Analyze > Set measurements’ and select ‘Area Fraction’ and ‘Limit to threshold’.
Using the selection tools, select a region of interest (ROI) for which a measurement is to
be made. For instance, select a well, using the ‘oval’ selection tool.

Click ‘Ctrl+M’ to obtain the percentage area mineralized in the ROl in a new ‘Results’

window which can be saved as an Excel file.

MLO-Y4 survival and dendricity

Experiments with MLO-Y4 cells can be set-up in collagen-coated multiwell plates at a seeding

density of 8x10° cells/cm?. Outcomes of cell survival and dendricity could be assessed by

counting cell numbers, mean dendrites per cell and mean dendritic length from crystal violet

stained cultures.

1.

At the end of an experiment, wash the cells with PBS and fix in 10% buffered formalin
for 15 min.

Rinse with H,0 and stain the cells with 0.1% crystal violet stain for 10 min.
Subsequently, remove excess stain and rinse cells with H,O several times to remove any

unbound stain (until the solution is clear).



4, Leave the cultures to air dry overnight and image at 200X magnification for
guantification. It is advisable to measure the outcomes from at least three technical
replicates per experiment to get reliable set of results.

5. Count mean cell number per field of view using any image analysis software with a cell
counter such as Imagel or cellD (Olympus, Southend-on-Sea, UK). A typical count ranges

from 25-30 cells per field of view (see Note 7).

Quantification of dendricity using cellD

1. Open the image in cellD and set the magnification of the original photo if it is captured
using a different software by clicking ‘Image > Set magnification’. Ensure that the units
are set correctly.

2. Using the ‘closed polygon’ selection tool, draw around all the cell bodies, right-clicking
to end tracing for each cell (figure 2; see Note 7).

3. Choose the ‘polyline’ tool and trace along the dendrites for each cell from the tip of the
extension to the traced cellular body (figure 2).

4, After tracing all the cell bodies and the dendrites for an image, count the total number
of dendrites for each cell using the ‘touch count’ tool.

5. Click ‘Create Measurement Sheet’ to obtain to individual dendrite length and total
number of dendrites in separate columns. The results sheet can be exported as an Excel
file.

6. Calculate the mean dendrite length and mean number of dendrites per cell to describe

the dendricity of the cells.

NOTES

1. The authors routinely use a 48-well plate for mineralization experiments with MLO-A5
cells. When using a 96-well plate if measuring mineralization by image analysis, the
shadow of the wells may not allow for consistent thresholding, although a backlit

scanner can be used to resolve this issue.
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Ascorbic acid is needed for collagen secretion and serves as a cofactor for prolyl
hydroxylase which catalyses the hydroxylation of proline residues, integral to the
stability of collagen triple helix [22, 23]. Ascorbic acid and dexamethasone are known to
upregulate alkaline phosphatase and osteocalcin expression promoting mineralization
[23, 24] We recommend making a 1000X stock (50mg/mL) of ascorbic acid to be diluted
1:1000 in feeding media to obtain the working concentration. Ascorbic acid is not stable
and should be added fresh each time, unless a more stale form of ascorbic acid is used.
Dexamethasone stocks of 10mM (10° X) are prepared in methanol and serially diluted to
1000X of working concentration in media. This is further diluted 1:1000 in the feeding
media to give the working concentration.

2mM beta-glycerophosphate can also be used instead of iPO4 to promote
mineralization.

Alizarin Red is an anthraquinone dye that binds to calcium deposits as confirmed by
energy dispersive X-ray spectroscopy [25]. An alternative method for quantification of
mineralization, based on extraction of the bound dye, is used by some researchers. In
our experience, the amount of dye released following extraction can be inconsistent and
variable. For those who are nevertheless interested in Alizarin Red dye extraction can
find the details on the protocol in ref [26].

Tightly packing of some clean cotton wool into each well is recommended prior to
scanning to achieve a good contrast in the scanned image. Otherwise, using a backlit
scanner can be used to resolve this issue.

It is recommended to use the same thresholding parameters for all cultures stained
simultaneously. The thresholding parameters may change for different batches of
staining and therefore it is advised to have experimental controls for each batch of
staining; e.g. at least one well containing a known batch of cells that consistently
produces bone nodules. The data can then be represented as relative to these

experimental controls to reduce variability.
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7. Only cells which are completely within the field of view should be included in the
measurements. Cells on the edges may have it dendrites outside the field of view and

could make the results inconsistent.

12



PROTOCOL IlI: Isolation and Culture of Primary Mouse Osteocytes

MATERIALS

Cell isolation and culture reagents

1.

Collagenase Solution (50ml): 300 active units/ml Collagenase Type IA (Sigma) dissolved
in a-minimum essential media (dMEM) (Mediatech Inc., Manassas, VA) containing 100
units/ml penicillin and 50 pg/ml streptomycin (Sigma).

EDTA Solution (30ml): 5 mM ethylenediaminetetraacetic acid tetrasodium salt
dehydrate (EDTA) (Sigma) dissolved in Ca%* and Mg?* - free Dulbecco’s phosphate
buffered solution (DPBS) (Mediatech) containing 0.1% bovine serum albumin (BSA)
(Sigma). The pH of the solution should be adjusted to 7.4.

Culture Medium: aMEM supplemented with 5% heat-inactivated FBS and 5% heat
inactivated CS (Hyclone Laboratories, Logan, UT), 100 units/mL penicillin and 50 pg/ml
streptomycin.

Ca?* and Mg?* - free Hank’s balanced salt solution (HBSS; Mediatech) supplemented with
100 units/ml penicillin, 50 pg/ml streptomycin and 25 pg/ml gentamicin (Sigma)

aMEM supplemented with 100 units/ml penicillin, 50 ug/ml streptomycin and 25 pg/ml
gentamicin.

25 or 27 gauge needles and 1ml syringes

(Optional) Medimachine tissue homogenizer (BD Biosciences, San Jose, CA)

(Optional) Medimachine Filcon cartridges (50 uM pore size)

13



METHODS

Cell isolation and culture

Start with coating the tissue culture plastic with collagen type |, as described in “Coating tissue

culture plastic with collagen” for protocol I. All dissection equipment should be sterilized in 70%

ethanol prior to use. The collagenase and EDTA solutions should be warmed to 37°C before use.

1. Carefully dissect the limbs (tibiae, femora and humeri) from two mice, transfer to a
sterile culture hood and place into a 100 mm petri dish containing aMEM with
antibiotics.

2. Remove the muscle and soft tissue from around the bones. Scrape off the periosteum
using a sterile scalpel.

3. Wash the bones 3 times with aMEM containing antibiotics.

4, Transfer bones to a 100 mm petri dish containing aMEM with antibiotics, remove the
epiphyses and flush the marrow using a needle and syringe until no marrow remains.

5. Dissect the bones into 1-2 mm sized pieces using a fresh scalpel and wash in HBSS
containing antibiotics.

6. Transfer the bone pieces into a well of a 6 well plate containing 8 ml collagenase and
incubate for 25 minutes on a shaking/rotating platform at 37°C.

7. Remove and discard the collagenase, rinse the bone pieces 3 times with 5 ml HBSS and
discard the rinsate. This is digest 1 and the cells released from this digest are primarily
fibroblastic.

8. Repeat the collagenase digest twice, for digests 2 and 3. These cells will be a mixture of
fibroblasts and osteoblasts and can be discarded.

9. Incubate the bone pieces in 8 ml EDTA for 25 minutes on a shaking/rotating platform at
37°C. Remove and discard the EDTA, rinse the bone pieces 3 times with 5 ml HBSS and
discard the rinsate. This is digest 4.

10. Incubate the bone pieces with 8 ml collagenase for 25 minutes on a shaking/rotating
platform at 37°C. Remove and discard the collagenase and rinse the bone pieces 3 times

with HBSS. This is digest 5 and contains mainly osteoblasts.

14



11.

12.

13.

14.

15.

16.

Incubate the bone pieces with 8 ml EDTA as for step 9. This is digest 6 and contains
mainly osteoblasts.

Incubate the bone pieces with 8 ml collagenase as for step 10. This is digest 7 and
contains mainly osteoblasts and osteocytes.

Incubate the bone pieces with 8 ml EDTA as for step 9. This is digest 8 and contains
mainly osteoblasts and osteocytes.

Incubate the bone pieces with 8 ml collagenase for 25 minutes at 37°C. This is digest 9
and contains primarily osteocytes. Following the digestion, transfer the collagenase to a
50 ml centrifuge tube. Rinse the bone pieces 3 times with HBSS and transfer the rinsate
to the same tube.

Centrifuge the digest at 1000 x g, resuspend in 2ml culture media and transfer to a well
of a collagen-coated 6 well plate.

The cells will attach within 24-48 hours and should be used within 7 days of plating to

prevent loss of phenotype or overgrowth with osteoblasts.

Isolation of cells from bone particles

To improve the yield, the digested bone pieces can be homogenized to release osteocytes

remaining within the bone pieces after digestion by using the following protocol:

1.
2.

Dissect the bone pieces into smaller fragments with a sterile scalpel.

Place in a Falcon cartridge with 1 ml culture media and mince in a Medimachine
homogenizer.

Transfer the resulting bone particles in culture media to a well of a collagen-coated 6
well plate. The particles from two mice can be divided between 2 wells of a 6-well plate.
Add another 1 ml of culture media and culture the particles for 72 hours undisturbed.
After 72 hours, add 1 ml of culture media.

Replace the media with fresh culture media after a further 48 hours (5 days after
plating).

Osteocytes can be observed in the well after approximately 5 days and should be used

for experiments within 7 days of plating.

15



NOTES

The cells isolated from digest 9 and the bone particles are alkaline phosphatase
negative, E11 antigen positive, and display a dendritic morphology as described in [27]
To further increase the cell yield, the cells from digests 7 and 8 may also be harvested in
addition to digest 9. These digests contain many osteocytes, but will be more
heterogeneous than digest 9, which contains primarily osteocytes. Cell fractions after
EDTA or collagenase digest should be preferably collected into serum-containing culture
medium and kept on ice prior to seeding.

If osteoblasts are also required for cultures, these can be harvested from digests 5 and
6. Earlier digests contain a relatively large amount of fibroblasts.

If the bones from more than two mice are being used, the volumes of collagenase and
EDTA solutions can be scaled up accordingly.

Note that even digest 8 and 9 still contain other cells than osteocytes (e.g. cells from the
hematopoietic lineage, osteoblasts and fibroblasts). Fibroblasts can quickly overgrow
the osteocyte cultures, and primary osteocytes lose their osteocyte-like phenotype in
two dimensional culture, limiting the life span of these osteocyte-rich cultures. Cells
obtained are best used within days. In addition, the presence of cell types other than
osteocytes can affect the results obtained [28], and care should be taken when drawing
conclusions about osteocyte properties when experiments are performed using primary

cell cultures.
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PROTOCOL lil: Culture of Bone Pieces containing Osteocytes

The authors of this section prefer to use trabecular bone samples obtained from the anterior
iliac crest, since this bone can be obtained from healthy people as surgical waste material when
originally harvested for e.g. sinus floor elevation surgery. Trabecular bone can also be obtained
in large quantities during total hip or knee replacement surgery for osteoarthritis, but one

should keep in mind that this bone might differ in cell consistency from healthy bone.

MATERIALS

Instruments

1. Scalpels (no. 10 and 11), scissors, tweezers and curved forceps

2. 10 ml syringes and 0.2 pm disposable filter units (Schleicker & Schuell GmbH, Dassel,
Germany)

3. 12 well culture plates (Greiner Bio-One, Frickenhausen, Germany), 94/16 mm CellStar

Petri dishes (Greiner), and 145/20 mm CellStar (large) Petri dishes

4, Conical base, 15 and 50 ml polypropylene centrifuge tubes (Greiner)

5. Microtome, e.g. Leica/Reichert-Jung Polycut S (SM2500) microtome (Nussolch,
Germany)

6. Light microscope

Media and solutions for culture

1. Sterile PBS, pH 7.4

2. Dulbecco’s Modified Eagle’s medium (DMEM), with 1 g/l glucose, L-glutamine, and
pyruvate

3. cCM: DMEM supplemented with 100 U/ml penicillin, 50 ug/ml streptomycin sulphate,

50 ug/ml gentamycin, 1.25 pg/ml fungizone, and 10% Fetal clone serum (make fresh

before each medium change and filter sterilize)

17



4, Collagenase Il (260 U/mg; Worthington, Lakewood, NJ, USA) in DMEM (make fresh and
filter sterilize)

Histology

1. Ethidium Homodimer-1 kit (Life technologies, Carlsbad, CA)

2. Ethanol, methanol, hydrogen peroxide (H20z), and 4% phosphate-buffered
formaldehyde

3. methylmethacrylate (MMA; BDH Chemicals, Poole, England) supplemented with 20%
plastoid-N (R6hm und Haas, Darmstadt, Germany), 2.0 g/L benzoylperoxide (Merck,
Darmstadt, Germany), and N,N-dimethylaniline (Merck)

4, Mouse-anti-sclerostin antibody (R&D Systems)

5. Biotinylated rabbit-anti-mouse antibody (Dako)

6. Horse radish peroxidase-labeled streptavidin (Invitrogen)

7. 3-amino-9-ethylcarbazole (AEC) reagent (Life Technologies)

8. Hematoxylin

METHODS

Preparation and culture of human bone pieces containing osteocytes

1.
2.

Collect the trabecular bone samples in sterile PBS with antimicrobial agents (figure 3A).
Transfer the bone biopsy to a petri dish and wash three times with PBS to remove all the
blood and clots (figure 3B).

Cut the trabecular bone from the bone pieces using a number 23 scalpel in petri dish
with PBS. Discard the cortical bone. Wash the trabecular pieces frequently during the
cutting to remove the blood, clots and bone marrow.

Once you have separate trabecular bone pieces from the cortical bone, change the

number 10 blade and chop the trabecular bone pieces in to further small pieces (~1-2

18



10.

11.

mm?). During the chopping wash the bone pieces frequently by PBS and avoid drying of
bone pieces.

Prepare 2mg/ml collagenase Il solution in serum free DMEM and filter it using 0.2 um
disposable filter unit.

Transfer the bone pieces in to 50 ml centrifuge tube containing collagenase Il solution
and mix well. The Volume of the collagenase Il solution you add should be at least
double of the total volume of the bone pieces.

Incubate the bone pieces with collagenase Il for 2 h at 37°C in a shaking water bath to
remove all the adhering cells from the bone piece surfaces. Shake the tube manually
every 30 min to disperse the bone pieces properly in the collagenase Il solution.

Wash the bone pieces with DMEM containing 10% fetal Clone | serum.

Transfer the bone pieces to a petri dish, and subdivide into equal portions of
approximately 100 mg.

Transfer approximately 100 mg of bone pieces to a well of a 12 well culture plate, and
add cCM (figure 3E). Incubate overnight in 37°C and 5% CO.. The next day, wash the
bone pieces with PBS 4-5 times and continue the culture with cCM at 37°C and 5% CO;
(figure 3F).

Continue the culture up to 7 days. Replenish the medium twice a week. During this
culture period, chemicals, hormones, cytokines etc. can be added to the osteocyte
culture, and the production of signaling factors by the osteocytes can be measured in
the conditioned culture medium. Total RNA can be isolated from the bone pieces using

trizol for further analysis of the osteocyte responses.

Visualization of live osteocytes at day 7

1.
2.

Wash the bone pieces with PBS.

Stain the bone pieces with live-dead staining solution according to manufacturer’s
instruction; Ethidium Homodimer-1 kit (Life technologies, Carlsbad, CA).

Observe the live and dead cells in or on the bone pieces with a microscope, such as the

Zeiss Apotome 2 microscope (figure 4A; see Note 1).
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Immunohistochemistry for sclerostin production by osteocytes at day 7

Detection of sclerostin will confirm the presence of osteocytes in the bone pieces.

1. At day 7, fix some of the bone pieces in cold 4% phosphate-buffered formaldehyde
2. Dehydrate in graded ethanol, make sure to completely dehydrate by repeating the

incubation in 100% ethanol at least twice, and embed in methylmethacrylate mixture.

3. Cut the sections of 5 um, for instance with a Leica/Reichert-Jung Polycut S (SM2500)
microtome.
4, Rehydrate the sections and quench endogenous peroxidase with 3% H,0, in 40%

methanol in PBS.

5. For antigen retrieval incubate the sections with 1% trypsin for 15 min at 37°C.
6. Block the non-specific binding sites with 5% normal rabbit serum for 1 h.
7. Incubate the sections overnight at 4°C with 1/200 mouse-anti-sclerostin antibody

(primary antibody).

8. Incubate the sections for 1 h with 1/100 biotinylated rabbit-anti-mouse antibody
(secondary antibody) and for 1 h with horse radish peroxidase-labeled streptavidin.

9. For color development incubate the sections with 3-amino-9-ethylcarbazole reagent and

counter stain with hematoxylin.

10. Visualize the sclerostin staining under the light microscope (figure 4B).
NOTES
1. Vital bone cells were visualized on the surface of bone pieces after 7 days of culture, but

these cells did not produce sclerostin or DKK1. Since the bone pieces were denuded by
collagenase-2 treatment, these cells might be cells that have grown out from recently

formed osteoid.

RECOMMENDED FUTURE READING
The basis for many protocols for the isolation of osteoblasts or osteocyte-like cells from bone is

formed by the avian osteocyte isolation protocol, which has been described in detail the
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following publication: Semeins CM et al., Isolation of primary avian osteocytes. Methods Mol
Biol. 2012;816:43-53. [29]. The isolation of primary mouse osteoblasts has also been described
in detail elsewhere [27]. For those of you interested in subjecting cultured osteocytes to a
precisely controlled mechanical stimulation, several methods for mechanical stimulation of 2
dimensionally cultured skeletal cells have been described in detail in the following publication:
Huesa C and Bakker AD. Mechanical stimulation of bone cells using fluid flow. Methods Mol

Biol. 2012;816:573-92 [30].
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FIGURE LEGENDS

Figure 1: Quantification of mineralization using Imagel.

A) Representative image of a mineralization experiment stained with alizarin red. B) The image
in A was color thresholded (black) to select the deep red stained mineral deposits. The
thresholding was kept consistent for all wells stained at the same time. C) The color
thresholded image in B was converted to a grayscale 8-bit image. D) The grayscale image was
thresholded (red) to select the previously color thresholded black region, and the area fraction

of mineralization for the well was measured.

Figure 2: Quantification of osteocyte dendricity.
Osteocyte dendricity is assessed by counting the number of dendrites per cell, and the average
length of dendrites, using CellD. A typical field of view for crystal violet stained osteocytes with

dendrite measurements is depicted in the zoomed in image.

Figure 3: Human bone pieces preparation and culture.

A) Human bone biopsy obtained from iliac crest. B) lliac crest biopsy washed with PBS. C)
Trabecular bone chopped in to small pieces. D) Bone pieces treated with 2 mg/ml collagenase |l
for 2 hrs. E) Human bone pieces transferred to complete culture medium in the well of 12 wells
culture plate. F) White porous trabecular bone pieces after 24 hrs of culture (washed 4-5 times

with PBS).
Figure 4: Live osteocytes in bone pieces produce sclerostin during the culture.

A) Dark green cells: live osteocytes, Dark red cells: dead osteocytes at day 7. B) Sclerostin

detected in osteocytes in bone pieces.
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